
                        
Quick Start Guide for Macintosh 

The Eudora® 5.0 User Manual for Macintosh is on the Eudora CD included in the product 
box. If you prefer a printed and bound copy, you can purchase one from www.eudora.com 
or call 1-800-2-EUDORA (1-800-238-3672).

Introduction

This Quick Start Guide shows how to install and configure the Eudora software. It also 
provides keystroke shortcuts and basic email procedures such as sending and receiving 
messages. For the Windows version, turn the booklet over.

Finding Information

You can find more information about Eudora in the Eudora 5.0 User Manual for Macintosh 
included on the Eudora CD. The manual is in Portable Document Format (PDF). To read 
the manual, use Adobe® Acrobat Reader, a software utility included on the Eudora CD. 

After you install Eudora, you can access the manual and other Eudora documents by 
opening the Eudora folder and then the Documentation folder. To open the manual, 
double-click the user manual icon; Acrobat Reader automatically opens it.

The manual topics are linked. When you see a topic associated with a page number asso-
ciated to a topic in the table of contents, index, or in a cross-reference, click the topic or 
page number and that topic appears.

If you prefer, you can print the PDF manual. From the File menu in Acrobat Reader, 
choose Print. 

If you need help while using Eudora, go to the Help menu and choose a topic or turn the 
Balloon Help on.

System Requirements

To use Eudora, you must have at least the following:

■ Macintosh® PowerPC processor running Macintosh OS 8.1 or later

■ Network or Internet mail account that uses POP3 or IMAP4 protocol

■ Access to your mail account via a TCP/IP (Internet) network connection or via PPP 
dial-up networking through a modem
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Getting Started

Before you can successfully install Eudora, you need to know the following basic informa-
tion about your email account. Either your Internet Service Provider (ISP) or your email 
administrator can provide you with this information.

■ Return email address (Return address)

This is the email address that has been assigned to you by your ISP or your organization. 
It is the address other people use to send you email. An example return address is 
jim@myfirm.com

Record your Return address here.

■ User name (Username)

This is the name you use to log into your email account. Your ISP or organization provides 
it. It is generally, but not necessarily, the name that appears before the at sign (@) in your 
return email address (in the example above, "jim" is the user name).

Record your Username here.

■ Mail account password

This password lets you access your email account. Your ISP or organization provides it. 
Keep this password private. 

■ Incoming mail server name (Mail Server)

Your incoming email account resides on a computer at your ISP or within your organiza-
tion. Your incoming mail server name is the Internet server name of that computer (for 
example, pop3mail.myfirm.com).

Record your incoming mail server name (Mail Server name) here.

■ POP or IMAP

This is the protocol that your incoming mail server uses. Your incoming mail server uses 
one of the following two Internet protocols, POP or IMAP, for storing and forwarding your 
mail. Ask your ISP or your email administrator which one it uses.

If you are setting up an IMAP account, it may require an IMAP Mailbox Location Prefix. 
Obtain this from your ISP or your email administrator. Otherwise, leave the following box 
blank.
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If applicable, record your IMAP Mailbox Location Prefix here.

■ Outgoing Mail Server Name

This server, an SMTP server, receives and processes all of your outgoing mail. It also 
resides on a computer at your ISP or within your organization. The server name is often 
the same as your incoming mail server name. Your SMTP server name is the full name of 
that computer, for example, smtp.myfirm.com. If your ISP or your email administrator has 
not given this server name to you, you can leave the box blank.

Record your SMTP Server name here (if known).

Installing Eudora

After you have recorded the previous information, you are ready to install, configure, 
choose a Eudora mode, and register your copy of Eudora.

If you are installing over a previous version of Eudora, all of your messages, mailboxes, 
folders, filters, and settings are maintained as long as you install Eudora in the same loca-
tion as your previous version.

To install Eudora, do the following:

1 Turn off any virus-protection software installed on your computer. Restart your Macin-
tosh.

Important. Do not restart your Macintosh with extensions OFF because the installation 
CD will not mount onto your desktop.

2 If you are installing Eudora from a CD-ROM, insert the Eudora CD into your Macintosh 
CD-ROM drive. If you are installing Eudora from a software archive, double-click the 
archive.

3 Double-click the Eudora 5.0 installer icon to launch the install program.

4 Click Continue in the Installer window, or press Return or Enter.

5 Read the Readme and click Continue. (To save the Readme to a file, click Save. To 
print the Readme, click Print.)

6 Read the Software License Agreement and if you agree to the terms, click Agree. The 
Eudora Install dialog appears.

7 To install Eudora and all of the items listed, choose Easy Install and click Install. Easy 
Install is the default, and it installs all elements of version 5.0. To install Eudora only, 
choose Custom Install. 

Note. By choosing the Easy Install, QUALCOMM’s PureVoice™ voice-messaging soft-
ware will install. If you install Eudora from a CD, an option will appear to install Apple’s 
QuickTime™
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multimedia software. If you have a newer version of QuickTime, it will not be replaced. 
If you get Eudora from the Internet, you can retrieve and install QuickTime separately 
from Eudora.

By choosing Custom Install, you can choose which items you want to install. To see a 
description of an item, click the item.

8 When asked where you want to install the Eudora Application, choose the destination 
folder and click Install. A dialog appears indicating that your Macintosh may need to be 
restarted following installation.

The install program begins installing the Eudora files into the appropriate locations on 
your disk.

9 Open the Eudora Application Folder, which you just installed in the destination folder 
you 
specified above. If you want to install any of the supplementary software, double-click 
the installer icon of the item. The application icon to open Eudora is located in the 
Eudora Application Folder.

Opening and Configuring Eudora

After you have successfully installed Eudora, you must configure your email account using 
the 
information you entered in the Getting Started section of this guide.

Important. Your older Eudora mailboxes, settings, etc. are used automatically by this most 
current version of Eudora. These files reside either in the System or Documents folder 
depending on which Mac OS your system is using. This folder is named Eudora Folder. 
Don’t move this folder if you want to keep your previous settings. Only the "Application" 
folder will be changed by the Eudora installer.

Getting Started Settings

Open Eudora. Go to the Eudora Application Folder and double-click the Eudora applica-
tion icon. The first time you launch Eudora, a popup dialog asks you if want to import 
settings and mail from another email application (see the next section). If not, the Getting 
Started dialog of the Settings options appears.

Sample Getting Started Settings dialog
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To check your settings according to the instructions here, or anytime after launching 
Eudora, choose Settings from the Special menu and click the Getting Started category 
icon in the left column.

In the Getting Started Settings dialog, enter the following information:

■ Your Username (recorded earlier)

■ Your Mail Server (incoming mail server name, recorded earlier)

■ Your Real name (your first and last name as you wish it to appear in the sender line of 
your outgoing mail)

■ SMTP Server (outgoing mail server name, recorded earlier)

■ Return address (recorded earlier), if it is different from the address you would get if 
you combine your Username and Mail Server thus username@mailserver.com

When you finish entering this information, click OK to save your changes.

POP or IMAP

You need to tell Eudora which Internet protocol your incoming mail server uses, as you 
recorded it earlier in this guide.

1 Open the Settings dialog by selecting Settings from the Special menu.

2 Click the Checking Mail category icon in the left column. The Checking Mail settings 
dialog appears.

Sample Checking Mail Settings dialog 

3 In the Mail Protocol field, click POP or IMAP, depending on what you recorded earlier 
in this guide. (If you are not sure, click POP. You can always change it later.)

Note. If you choose the IMAP mail protocol and you recorded an IMAP Mailbox Loca-
tion Prefix earlier in this guide, enter that information in the IMAP Mailbox Location 
Prefix field that appears.

4 Click OK to save your changes.
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SMTP Server Settings (if necessary)

If your SMTP (outgoing) server is on a different computer than your incoming mail server 
(your ISP or email administrator can provide you this information), you need to do the 
following after you have filled in the Getting Started Settings dialog:

1 Open the Settings dialog by selecting Settings from the Special menu.

2 Click the Sending Mail category icon in the left column. The Sending Mail settings 
dialog appears.

3 In the Default Domain field, enter the domain name, if any. (So, if you enter 
myfirm.com in this field and you address a message to bill.jones, Eudora will expand 
the address as bill.jones@myfirm.com before sending or queuing the message.)

4 In the SMTP Server field, enter the name of your outgoing (SMTP) server if you didn’t 
enter it in the Getting Started dialog. Click OK to save your changes. 

Once you have configured Eudora, you are ready to begin sending and receiving 
messages. However, you may want to change the Eudora operating mode and register 
your copy of Eudora. (See “Operating Eudora in One of Three Modes” on page 7).

Importing Mail and Address Book from another Email 
Application

To set up a newly migrated account from Microsoft Outlook Express 5.0 as a new account 
in Eudora, do the following:

1 If you have not configured your Dominant personality (account) when setting up 
Eudora, a dialog appears asking you if want to import settings and mail from another 
email account. Click Yes. The account you import will become your Dominant person-
ality. 

Or if you have set up your Dominant personality in Eudora, but would like to set up 
another account using the settings from another email account, go to the File menu, 
and choose Import Mail. The Email Importer dialog appears. 

Email Importer dialog 

2 Choose the email account from the list and click Import Account. To choose a mail 
folder to import via a standard file dialog, click Select Other. Once an account is 
selected to import, The Import Mail dialog appears.

3 Choose the items you wish to import into Eudora and click OK. Eudora transfers all the 
settings you’ve chosen to your new Eudora account.
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Operating Eudora in One of Three Modes 

You can choose one of three operating modes on how you wish to use Eudora. They are 
as follows:

■ Paid mode

This mode provides the full-featured Eudora desktop email client without advertising.

■ Sponsored mode

This mode provides the full-featured Eudora desktop email client at no charge, supported 
by sponsors' advertising. It includes all of the features that are in the Paid mode.

■ Light mode

This is an upgrade to the freeware version formerly known as Eudora Light. It includes 
fewer features than the other modes and a sponsor image or logo, but no advertising.

Choosing a Eudora Mode

If you bought Eudora from a retail store or from a web site, Eudora installs in Paid mode. 
However, if you would like to change the operating mode, for example to Sponsored mode, 
you can do so right in the Eudora program. (Remember to request a refund from QUAL-
COMM. See the last page of this guide for details.)

To change the Eudora operating mode after you install Eudora 5.0, do the following:

1 From the Help menu, choose Payment & Registration. The Payment and Registration 
window appears.

Payment and Registration window
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2 In the Which Eudora is right for you? section: 

■  To use Eudora in Sponsored mode, click Sponsored Mode (free, with ads). 
Eudora displays the ad window. 

■  To use Eudora in Paid mode, click Paid Mode (costs money, no ads). Eudora 
displays the Eudora web site for you to purchase Eudora.

■  To use Eudora in Light mode, click Light Mode (free, fewer features). Eudora 
changes to Light mode by shutting down certain features. The features that will be 
turned off are listed in the confirmation dialog.

Note. The grayed out button indicates the mode in which you are operating Eudora. 

Registering Eudora

If you are using Eudora in either Sponsored or Paid mode, you need to register to be 
eligible for technical support. If you don’t register or use Eudora in Light mode, you are not 
eligible for technical support.

If you switch from one mode to another, you must register in that mode even though you 
registered in another mode. For example, if you are a Paid mode registered user, and you 
wish to get a refund and use Sponsored mode, you must re-register in Sponsored mode.

To register your copy of Eudora, do the following:

1 From the Help menu, choose Payment & Registration. The Payment and Registration 
window appears.

2 In the Keeping Current section, click Register with Us. Eudora takes you to Eudora’s 
registration web page.

3 Enter your information, click Submit Registration. You will receive an email confirming 
your 
registration. 

Technical Support 

If you register your copy of Eudora in Sponsored or Paid mode, you are entitled to the 
following.

■ Paid mode—6 calls or email messages for 1 year.

■ Sponsored mode—6 calls or email messages per year if you stay in Sponsored 
mode.

■ Light mode—no technical support

Be sure to register as soon as possible to avoid any delays in receiving technical support.

Also, refer to the Eudora family of products technical support Web site, which includes a 
Frequently Asked Questions (FAQ) section, “how to” information and tutorials. Open the 
following web site: http://www.eudora.com/techsupport/Mac
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Eudora tech support representatives are available Monday through Friday from 8 a.m. to 5 
p.m. Pacific Time using the following phone number and email address:

Phone: (858) 658-1292

Email: eudora-support@eudora.com

When contacting us via telephone or email, you will be asked to provide the following:

■ Registration number

■ Eudora version, mode, and platform

■ System version

■ What you were doing when the problem occurred and any error messages (including 
error codes) that you received.

For a quick introduction to Eudora’s basic functions, refer to the procedures provided in 
this guide and to your online help, which you can access from the Eudora Help menu.
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Creating and Sending a Message

1 From the Message menu, choose New Message.

2 Type an email address in the To field.

3 Press Tab to move the cursor to the Subject field.

4 Type the subject of your message (optional, but recommended).

5 Press Tab and type in the Cc field email address (optional).

6 Press Tab and type in the Bcc field email address (optional).

7 Press Tab and type in the body of the message.

8 After completing the message, click Send.

Tip. You can type multiple addresses in the To, Cc, and Bcc fields, as long as you separate 
them with commas.

Also, you can save a message without sending it by selecting Save from the File menu. 
Your message is saved in the Out mailbox. It can be reopened and edited at any time prior 
to sending it.

Checking for and Receiving Mail

You can manually check for mail or set up Eudora to automatically check for mail.

Checking Mail Manually

1 From the File menu, choose Check Mail.

2 If Eudora asks for your password, type it in the Password dialog and click OK (server 
passwords are usually case-sensitive).

3  If there is no mail for you, a "no mail" alert appears. Click OK.

4 If you have new mail, Eudora transfers the messages one by one and then displays a 
"new mail" alert. Click OK.

New messages are delivered to your In mailbox. This mailbox opens automatically and 
your new message summaries are added to the end of the mailbox list. 

5 Double-click a message summary to open the message or read the message in the 
preview pane.

Automatic Mail Checking

1 From the Special menu, choose Settings. Then, click the Checking Mail category 
icon.

2 Click the checkbox for Check for mail every ___ minutes to turn on automatic mail 
checking. In the text box, type the number of minutes between automatic mail checks 
(15 is the recommended interval).
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3 To save your changes and close the Settings dialog, click OK.

Eudora automatically checks for mail at the interval you have requested.

Replying to a Message

1 Choose or open the message you want to reply to.

2 From the Message menu, choose Reply to display a new composition window. Eudora 
completes the To, From, and Subject fields based on the original message.

3 Remove those parts of the original text that you don’t want to include in your reply and 
type in your own text.

4 When you finish your response, click Send.

Forwarding a Message

1 Choose or open the message you want to forward.

2 From the Message menu, choose Forward to display a new composition window. 
Eudora completes the Subject field based on the original message and transfers the 
header and body of the original message to the new message body.

3 Type the addresses of the people you want to forward the message to in the To field.

4 The existing text may be edited, and more text may be added to the message.

5 After editing the message, click Send (or Queue) to forward it.

Redirecting a Message

Eudora’s Redirect command lets you pass on a received message that was intended for 
someone else, allowing that person to reply directly to the original sender.

1 Choose or open the message you want to redirect.

2 From the Message menu, choose Redirect to display a new composition window. 
Eudora completes the From field with the address of the originator, followed in paren-
theses by the words "by way of" and your name and/or email address. The Subject field 
and message body are also completed based on the original message.

3 Type the addresses of the people to whom you wish to redirect the message in the To 
field.

4 The existing text may be edited, and more text may be added to the message.

5 Once the editing is completed, click Send.

Note. Email courtesy suggests that you not do much editing of the message you’re redi-
recting. If you must add comments, put them in brackets [ ] with your initials, like this: [Don: 
Please reply to this right away. SD]
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Shortcuts

The shortcut keys for Eudora functions are the following:

Press these keys This will happen...

Command + . Stops the current action

Command + 0 Opens Out mailbox

Command + 1 Opens In mailbox)

Command + 6 Checks spelling 

Option + Command + 6 Finds next misspelling

Shift + Option + 
Command + 6

Adds word to dictionary

Command + - Sends queued messages

Command + = Enter selection (into Find window)

Command + \ Sends to back (move current window to the back of all Eudora 
windows)

Command + ’ Adds one level of excerpt bars

Command + Option + ’ Removes one level of excerpt bars

Command + , Finishes address book entry (finish nickname)

Command + [ Lowers priority

Command + ] Raises priority

Command + A Selects all

Command + B Makes the selected text bold

Command + C Copies

Command + D Deletes messages

Command + E Sends immediately, or queues for delivery

Command + F Finds (open the Find window to search for a text string in the 
current message)

Option + Command + F Searches for messages in mailboxes and folders

Command + G Finds again 

Command + H Attaches document... (attach a file to a message)

Command + I Makes the selected text italic

Command + J Filters messages (execute manual filters on the selected 
messages)

Command + K Makes address book entry... (make nickname)
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Command + L Opens address book

Command + M Checks mail

Command + N Opens new message

Command + O Opens file

Command + P Prints

Command + Q Quits Eudora

Command + R Replies

Command + S Saves

Command + T Makes the selected text plain

Command + U Makes the selected text underlined

Command + V Pastes

Command + W Closes the window or message

Command + X Cuts

Command + Y Opens Directory Services

Command + Z Undo/Redo

Arrows Moves from one message to another in a mailbox (depends on 
your Moving Around Settings)

Command + Arrows Moves from one file to another in the address book

Return or Enter Selects the outlined button in any dialog, alert, or window, or 
opens the selected message(s)

Spacebar Opens a selected message summary (or scrolls its preview 
down through the message preview panel), or closes the current 
open message. For long open messages, scrolls the message 
down one page

Esc Stops any operation currently in progress

Help Turns balloon help on or off

F1 Undo/Redo, or main toolbar function

F2 Cuts, or main toolbar function

F3 Copies, or main toolbar function

F4 Pastes, or main toolbar function

Home Scrolls the window to the beginning

End Scrolls the window to the end

Page Up, Page Down Scrolls up or down through the window

Press these keys This will happen...
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Note. Function keys can be linked to main toolbar buttons by turning on the Map function 
keys to buttons option in the Toolbar Settings (Special>Settings...>Toolbar).

Return Policy 

QUALCOMM offers a 30-day unconditional money back guarantee on all Eudora software 
products. If you would like to return Eudora (within 30 days from the date of purchase), or 
if you have any questions please call 1-800-2-EUDORA (1-800-238-3672) or email 
eudora-rep@qualcomm.com.

© 2000 QUALCOMM Incorporated, San Diego, CA 92121. All rights reserved. 
PureVoice is a trademark of QUALCOMM Incorporated. QuickTime is a trademark of 
Apple Computer, Inc. QuickTime is a trademark used under license, registered in the U.S. 
and other countries. All other trademarks are property of their respective owners. 

August 2000     
PM80-47928-6 MAC
14

QUALCOMM Incorporated


	Quick Start Guide for Macintosh
	Introduction
	Finding Information
	System Requirements
	Getting Started
	Installing Eudora
	Opening and Configuring Eudora
	Getting Started Settings
	POP or IMAP
	SMTP Server Settings (if necessary)

	Importing Mail and Address Book from another Email Application
	Operating Eudora in One of Three Modes
	Choosing a Eudora Mode
	Registering Eudora
	Technical Support
	Creating and Sending a Message
	Checking for and Receiving Mail
	Checking Mail Manually
	Automatic Mail Checking

	Replying to a Message
	Forwarding a Message
	Redirecting a Message
	Shortcuts
	Return Policy


